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We're here to help you any time of the day or night, to make sure you have a smooth end of financial year.

MYOB Support Notes - visit myob.com.au/supportnotes, where you can search our online knowledge base for answers to common questions

MYOB Community Forum - You can also ask your technical support questions at your online lifeline, the MYoB Community forum!  

for fast, personalised responses, post your question at community.myob.com

Live Chat - Chat online with an MYoB team member to resolve your query, anytime. go to myob.com.au/supportnotes 

Telephone - With MYoB 24/7 Support you can phone us anytime on 1300 555 123 and we’ll be here to help.

2

End of PAYRoLL YEAR guidE 2013  

http://myob.com.au/supportnotes
http://community.myob.com
http://myob.com.au/supportnotes


End of PAYRoLL  
YEAR PRoCESS
 
This guide is for: 
>  AccountRight Plus
> AccountRight Premier
>  AccountRight  Enterprise 
> AccountEdge
> AccountEdge Pro
> AccountEdge Network Edition

End of PAyRoll YEAR ContEntS
Step 1    Process the last pays for the year  4 
Step 2   Print the key payroll reports  4 
Step 3   Reconcile PAYg withholdings  5
Step 4   identify workers under labour hire arrangements  5
Step 5   Print Payment Summaries  6 
Step 6   Back up the company file  12 
Step 7   Close the payroll year 14
Step 8    Load new payroll tax tables 15

3

If you manage your payroll using AccountRight or AccountEdge, you’ll need to complete the following procedures 
after the last pay run of the 2012-2013 payroll year or before you enter pays for the 2013-2014 payroll year.
In this guide we’ll go through the steps to review your payroll, print Payment Summaries and close the payroll year.
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Step 1 Process the last pays for the year
Ensure that you’ve entered all pays to 30 June 2013 before continuing. in AccountRight Plus 2011 and later, make sure you don't have any saved pay runs that still need to be 
processed, as these will be cancelled when you close the payroll year. once you close the payroll year you won’t be able to enter or edit any pays dated in a closed payroll year.

Step 2 Print the key payroll reports
To print payroll reports
1.  go to the Reports menu and choose Index to Reports.
2.  Click the Payroll tab and print the following reports:
 >  Employees Activity Summary: Print this report for the full payroll year. this report lists each employee’s total wages, entitlements, deductions, employee expenses  

and taxes. the Activity Report derives its information from pays recorded using the Pay Employees function only, so it does not include any history that may have 
been manually entered in the employee’s card.

 >  Employees Register Summary: Print this report for the full payroll year. this report lists each employee’s total wages, entitlements, deductions, employee 
expenses and taxes but derives its information from the payroll history contained in the employee cards only. the payroll history is also the basis for the 
information used by the Payment Summary Assistant.

 >  Entitlements Balance Detail: Print this report to review your employees’ leave entitlements. Choose the date range 01/07/12 to 30/06/13 as the period to identify 
the current balances for each employee. the opening hours will include the carry over figure and the total available hours indicate the lifetime balance.

 >  Superannuation reports: Make sure you’ve printed your superannuation reports for the month of June 2013 or the April-June quarter. Superannuation reports for 
these periods cannot be generated once you close the payroll year, so print them to ensure that you have enough information to pay your super contributions.

NOTE: if you’ve made direct adjustments to the payroll history information in your employees’ cards, the Employees Activity and Employees Register reports will not match.
the only time these reports should differ is when you’ve commenced using the payroll function part-way through the year and have entered opening payroll balances 
in the Pay History tab of your employee cards. if a mistake has been made on a Pay Employee transaction, you shouldn’t manually adjust the payroll history within an 
employee card, as there will be no audit trail and the general ledger accounts will not be updated. instead, you should delete the incorrect pay and re-enter it.  
Also note that Payment Summaries retrieve their figures from the employee Payroll History, so if this information is incorrect, the Payment Summaries will also be incorrect.
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Step 3 Reconcile PAYg withholdings
using the payroll reports that you printed at step 2, you should now be able to reconcile your year-to-date PAYg withholding figures.
this process will check that you’ve remitted the full amount of PAYg withholdings that were collected during the payroll year.
to reconcile PAYg withholdings you’ll need to total all the payments that have been made to the Australian taxation office during the year. Compare the total payments 
made to the Ato with the total PAYg figures appearing on the Employees Activity and Employees Register reports.
 
Total PAyG remitted to the ATo  $
Total PAyG showing on the Employees
Activity / Register reports  $
Variance  $
 
if there is a variance between the PAYg remitted to the Ato and the Payroll Activity and Payroll Register reports, you’ll need to print these payroll reports for each month 
and compare them to the figures paid to the Ato for the PAYg Withholdings until you find the discrepancy. (See Step 2 for reasons why the Employees Activity and 
Employees Register reports may not match).
You can also compare the total gross wages shown on the Employees Activity and Employees Register reports with the Wages expense account in the Profit and Loss 
Statement for the payroll year. if the two figures do not match (remember to take into account any allowances paid into other accounts), you’ll need to print the Employees 
Activity and Employees Register report for each month and compare it to the monthly Profit and Loss Statements until you find the discrepancy.

Step 4 identify workers under labour hire arrangements
the Payment Summary information that you send to the Ato via the EMPduPE file should not include payments made to workers under labour hire arrangements.
To exclude employees with labour hire arrangements from the EMPDUPE file
1.  go to the Card File command centre and click Cards List.
2.   Click the Employees tab and click the zoom arrow of an employee that has a labour hire arrangement.
3.  Click the Payroll Details tab and check that Labour hire is selected from the Employment Basis drop-down list.
4.  Repeat these steps for the other employees with labour hire arrangements.
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Step 5 Print Payment Summaries
once all payroll transactions have been entered and your PAYg withholdings have been reconciled, you’re ready to print the Payment Summaries for your employees. 
Remember that you can print the PAYg Payment Summaries as many times as you like.
TIP: if you’re unable to print the Payment Summaries before the first pay run of the new year, make two backups of your company file. then start a new payroll year and 
keep using the file. When you’re ready to print your Payment Summaries, restore a backup. give the restored file a name that easily identifies it as the “before new payroll 
year” file so that it’s not accidentally used to enter data for the new payroll year.
Record your backup file names and locations here:

1.

2.

Before preparing your Payment Summaries:
>  if you've made any EtP or CdEP payments to your employees in the 2012-13 financial year, you'll need to install the 2013 compliance update before preparing  

your Payment Summaries. for more information on getting the compliance update, visit myob.com.au/eofy . if you need more information on EtP and CdEP 
payments, refer to support note 35340 "ETP and CDEP payments for 2012/2013", which can be found at myob.com.au/supportnotes. 

> Make sure your employee cards contain a current address (including a city and postcode) and a tax file number.
> Have available all details of any fringe benefit amounts and reportable superannuation amounts for your employees.

To prepare your Payment Summaries
1.  go to the Payroll command centre and click Print Payment Summaries. the Payment Summary Assistant appears. the Payment Summary Assistant helps  
 you set up the information required for your Payment Summaries.
2. [AccountRight v19 and AccountEdge only] Select the Individual non-business and Employment termination payment option.
3.  Click Next. 
4.   Check Your Company’s Payment Summary information. this window displays your company’s name and address, as you entered it in the Company Information 

window when you set up the company file. this information will appear on your employees’ Payment Summaries, and also in the electronic file (the EMPduPE file) 
containing payment summary information that you’ll provide to the Ato.
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Ensure that this information is correct and also enter your company’s trading name if you wish.
NOTE: in the State field, you must select one of the following two- or three-character codes:

ACt Australian Capital territory
nSW new South Wales
nt  northern territory
QLd Queensland
SA  South Australia
tAS tasmania
ViC Victoria
WA  Western Australia
otH overseas addresses

if otH is selected (your company is a non-resident):
•  The Country field is activated. You must enter your company's country information in this field.
•  The Postcode field defaults to 9999 and cannot be changed.
•  The state and postcode as well as the town must all be reported in the Suburb/Town/City field.
for example, assume your address is 275 Central Park West, Apartment 14f, new York, nY uSA 10024.
this address would be entered as follows:
Street Address  - Line 1    275 Central Park West Street Address
     - Line 2    Apartment 14f
Suburb/town/City      new York, nY 10024
State          otH
Postcode         9999
Country         uSA

End of PAYRoLL YEAR guidE 2013  
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the Ato requires each business to provide contact information for the person who processed your business Payment Summaries as well as your  
company information.
if you have approval from the Ato, you can also specify an authorised signatory in this window; this person’s name will appear in the “Signature of Authorised  
Person” area on your employees’ Payment Summaries.
[AccountRight Plus 2011 and later only] if applicable, select the option I use a third party service provider to lodge my payment summaries, then click Next and enter 
the Service Provider details in the next window.
When you're satisfied with the entries in this window, click Next.

5. Set up the Payment Summary fields
indicate which payroll categories in your software are reported in each Payment 
Summary field on your employees’ Payment Summary. You can also enter a descriptive 
label for some fields and these will be printed with the amounts for the payroll 
categories you’ve linked to the fields. 
IMPORTANT: take care when completing this step. incorrectly selecting or  
omitting a category will result in erroneous amounts on the Payment Summaries.  
Refer to the PAYG Payment Summaries and Guidelines, available on the Ato website 
(ato.gov.au), for information about which wages and deductions should be selected for 
each field. use the following information to help you complete this window.

Gross Payments
Select the Gross Payments field on the left. the row will highlight. now, in the right 
hand column, select all wage-type categories that you want to include in the gross 
Payments box on the Payment Summary. to start with, you may select Base Hourly, 
Base Salary, Annual Leave and Personal Leave. Also select any relevant salary sacrifice 
categories. Even if only some of your employees are linked to a certain category, select 
it if any amounts for any employees have been allocated to that category.
NOTE: Ensure that you don’t select any Allowances, Lump Sum Payment categories, CdEP 
categories, deductions or taxes at this stage. Select only the wage-type categories.
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Allowances
Select the Allowance 1 field on the left, enter the name of an allowance paid to your employees in the Description column, and then select the relevant allowance category 
in the right hand column. Select Allowance 2, enter the description of another allowance, and then select the relevant allowance category in the right hand column.
Repeat this for any other allowances you may have. if you have more than nine allowances, enter eight of them as described above, then select Allowance 9, enter the 
description as Other and select the remaining allowance categories in the right hand column. 

Lump Sum Payments
if you’ve paid any amounts to your employees that belong to the Lump Sum Payments A, B, d and E boxes, you’ll need to select the appropriate field on the  
left-hand side and click on the right-hand side payroll categories that correspond to the box.
it’s recommended that you have dedicated payroll categories set up to report Lump Sum Payments. this enables you to easily report Lump Sum amounts separately  
to gross Payments.
NOTE: Lump Sum Payment C is for any Employment termination Payments (EtP) eg. cash sum on termination of employment. these payments need to  
be issued on a separate EtP Payment Summary, which is available in some more recent software versions as a part of the Payment Summary Assistant.  
Please contact the Ato for further information. 
Lump Sum Payment E refers to amounts received for back payment of salary or wages, which accrued more than 12 months ago.

Community Development Employment Project (CDEP) Salary or Wages
CdEP payments refer to salary or wages received by persons of Aboriginal or torres Strait island descent on a "work for the dole" project within their community.
if you've made CdEP payments, you'll need to install the 2013 compliance update before completing your payment summaries. then in the Payment Summary Assistant, 
you'll be able to select the CdEP field on the left and select the appropriate CdEP payroll category on the right.
not sure if you've made a CdEP payment in 2012-13 financial year? Refer to support note 35340 "ETP and CDEP payments for 2012/2013" , which can be found at  
myob.com.au/supportnotes. 

Tax Instalments Deducted
Select the Total Tax Withheld box on the left. on the right hand side, notice that the PAYg Withholding category is automatically selected. do not clear this category.
if you’ve set up other deductions to act as tax deductions (e.g. flat rate of 20% tax set up as a deduction) then also select these.
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Employment Termination Payments
if you've paid any amounts to your employees that are considered part of an employment termination payment (EtP), you'll need to install the 2013 compliance update 
before completing your payment summaries. then in the Payment Summary Assistant, select the appropriate EtP field on the left hand side and click the relevant payroll 
categories on the right hand side.
note sure if the payment was an EtP? Refer to support note 35340 "ETP and CDEP payments for 2012/2013", which can be found at myob.com.au/supportnotes. 
NOTE: this works best when you’ve set up wage categories especially for this payment type.
once you’ve selected all required payroll categories click Next.

6. Enter reportable employer superannuation contributions (RESC) 
Enter any applicable RESC amounts in this window. to do this, click the Link Superannuation Categories button and select the superannuation payroll categories that 
are reportable, for example Salary Sacrifice and Employer Additional. You can also manually enter amounts next to an employee’s name.  
NOTE:  Reporting the correct superannuation amount 
Reportable superannuation amounts usually include salary sacrifice and over-award superannuation contributions. in most cases, superannuation guarantee and  
after-tax contributions are not reported. for more information about RESC, contact the Ato.
once you’ve entered or selected applicable RESC amounts, click Next.

7. Fringe benefits
Enter the Reportable fringe Benefit amounts earned by your employees during the corresponding fBt year (in 
whole dollar amounts).
Employers are required to record the taxable value of fringe benefits provided to individual employees. Where 
the total taxable value of fringe benefits provided to an employee exceeds $2000 in a fBt year, employers will be 
required to report the grossed-up taxable value of those benefits on the employee’s Payment Summary for the 
corresponding income year. for further information regarding reportable fringe benefits, visit the Ato web site at 
ato.gov.au.  After entering the Reportable fringe Benefit amounts, click Next.

8. Review Individual Payment Summaries  
You now have the opportunity to review the figures that will appear on each employee’s 
Payment Summary. Click the zoom arrow beside each employee’s name. You can change  
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the figures or descriptions given to the union fees or allowances for the individual employees. note that any figures that you change in this window will show with an 
asterisk (*) next to them. to change the figure(s) back to their original amounts click the Reset All button (the Recalc button in some versions).

IMPORTANT: You need to enter tax file numbers (tfn) for all employees whether you print Payment Summaries for them or not. You can enter your employees’ tfns in 
the Employee Payment Summary Information window or in the employee cards. if an employee does not have a tfn, use one of the following numbers provided by the 
Australian tax office:
PAYEE STATUS  TFN
New payee has not made a TFN Declaration, but 28 days have not passed  111 111 111
Payee is under 18 years of age and earnings do not exceed $350 per week,  
$700 per fortnight or $1,517 per month  333 333 333
Payee is an Australian Government pensioner payee 444 444 444
Payee chooses not to quote a TFN and has not claimed an exemption from quoting  
a TFN or does not fit into any of the above categories  000 000 000

9. Save and print Payment Summaries 
once you’ve reviewed the individual Payment Summaries, you have the option to Save and Print Payment Summaries. the entries will be checked for compliance with 
the Ato standards, for example the system will check that all employees have a valid tax file number. When you save the Payment Summaries you can choose where you 
want to save them.
10. Verify your Payroll Information
this window provides a summary of the number of records, total tax withheld, and total gross payments. Click Preview Verification Report to view a report showing 
details of amounts reported for each employee. You can use this report to complete payment summaries manually if you want. 
Number of Records: this will be the number of employees whose information is contained in the EMPduPE file (even employees for whom Payment Summaries have 
not been printed). it does not include any employees whose Salary and tax is equal to $0.
Total Tax Withheld: this will be the total PAYg withheld for all employees.
Total Gross Payments: this includes total salary and wages for all employees. it does not include Allowances or Lump Sum Payments. Also note that each employee’s 
total gross Payments will truncate the cents (as Payment Summaries do not include cents).
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11. Create the EMPDUPE File
this window contains important information about the EMPduPE file. the EMPduPE file contains payroll information 
for all individual non-Business employees, whether or not you’ve selected to print Payroll Summaries for them.  Before 
creating the EMPduPE file, you should be sure that you’ve printed or saved all Payment Summaries and verified that 
the amounts on these Payment Summaries are accurate. disks sent to the Ato must be in an Ato-acceptable format, 
such as Cd or dVd.See the Ato website for details of acceptable electronic media.
Click Create EMPDUPE file. 
the Magnetic Media information form is created by clicking on Print Magnetic Media Form.  
You’ll need to complete this form and send it to the Ato, attached to the disk containing the EMPduPE file.
this final window in the Payment Summary Assistant lets you backup your company file.  
You can click Backup here, or proceed to Step 6 below.

12.  Finish

Click Finish to close the Payment Summary Assistant window.

Step 6 Back up the company file
Make two backups of your company file after entering all transactions up to 30 June 2013.
name and label your backups carefully and note down the last cheque and invoice numbers  (this will help you identify those tricky June-July transactions later).
for example, name the backup file “Company_name_10A” and label the disk “Company name, 30/6/13, Chq 100, inv 10001, Backup A”.
Store one backup in your business premises and the other in a secure location away from your business. Record your backup file names and locations here: 

1.

2.

End of PAYRoLL YEAR guidE 2013  



13

To back up your company file in AccountRight 2011 and later
1.  go to the File menu and choose Back Up. the Back Up Company File window appears.
2.  Select the location where you want to save the backup file. if you like, you can also specify a password to protect your backup file.
3.  Click Back Up. Your company file will be backed up to the specified location.

To back up your company file in AccountRight v19 and AccountEdge
1.   go to the File menu and choose Backup. the Company File Backup window appears.
2.  Select the Backup all data and Check Company File for errors options.
3.   Click Continue. the data verification process begins and the company file is checked for errors. When the data verification process is complete, a message appears, 

describing the results.
4.  if the verification process did not detect any errors, click OK. the Back Up window appears, prompting you to choose a location to save the backup.
5.  if the verification process did detect errors, run the optimisation Assistant to repair the company file. this assistant is capable of fixing certain types of data errors and 

can also make your company file more efficient.
  to run the optimisation Assistant, go to the File menu and choose Optimise Company File.
  once you’ve optimised the file, perform the data verification procedure again to determine if the data errors have been repaired. if errors continue to be detected 

and the message refers to a particular transaction, open the transaction, review it or delete and re-enter it. if you receive a message referring to a record, such as an 
inventory item or tax code, open the record to investigate its setup.

  if the verification process does not specify transactions or records, you should restore the most recent backup of your company file and use that file instead.  
You should also check that company file for errors. MYoB also offer a company data file repair service. Visit myob.com.au/datafile_repair for more information.
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Step 7 Close the payroll year
When all the tasks above have been completed, you’re ready to close the payroll year (AccountRight 2011 and later) or start a new payroll year (AccountRight v19  
and AccountEdge).

After closing the payroll year:
•  You’ll be able to enter pays for the new year.
•  The previous year's Payroll History information will be cleared from the employee cards.
•  Entitlement balances will be cleared unless the Carry Remaining Leave Over to Next Year option is selected in the Entitlement Payroll Category windows   
 (accessible by going to the Lists menu, choosing Payroll Categories, and then Entitlements).

To close the payroll year in AccountRight 2011 and later
1.  go to the File menu, choose Close a Year and then choose Close a Payroll Year. the Close a Payroll Year Assistant appears.
2.  once you’ve read and understood the introduction, click Next.
3.  Specify the new payroll year. if you’re closing the payroll year ended 30 June 2013, you’d select 2014 as the new payroll year (as it covers the 2013/2014 years).
4.  Click Next.
5.  if you want to create a backup file before purging payroll information, click Back up and follow the instructions in the windows that appear.
6.  When you’re ready to close the year, click Close the Payroll Year. the Conclusion window shows the details of the new year.

To start a new payroll year in AccountRight v19 and AccountEdge
1.   go to the File menu, choose Start a New Year and then choose Start a New Payroll Year. the Start a New Payroll Year window appears. if you haven’t backed up your 

company file, click Backup.
2.   Click Continue. You’ll be presented with details of all the changes that will occur during the Start a new Payroll Year process. Read this carefully and then  

click Continue.
3.  Specify the new payroll year. if you’re closing the payroll year ended 30 June 2013, you’d select 2014 as the new payroll year (as it covers the 2013/2014 years).
4.   Click Continue. if you’ve backed up your company file, and are satisfied with the selections you’ve made in the Start a New Payroll Year windows,  

click Start a New Payroll Year. the process may take some time if you have a large number of transactions or records in your company file.
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Step 8 Load new payroll tax tables
After you roll over your payroll year and before you can enter pays in the new year, you need to ensure your software complies with the latest tax legislation 
applicable from July 1.
You can do this by installing the 2013 compliance update on every computer that has AccountRight or AccountEdge. this update will also guide you through 
increasing your mandatory superannuation deductions from 9% to 9.25%.
in AccountRight the compliance update can be downloaded from within your software by going to the Help menu and choosing Updates then choosing  
Check for Updates. in other versions, the compliance update is available by logging into my.MYoB (my.myob.com.au).
once you've updated your software, you can load the new tax tables. to do this, go to the Setup menu and choose Load Payroll Tax Tables, then click  
Load Tax Tables.

to check that you have the correct tax tables loaded, go to the Setup menu and choose General Payroll Information. in the window that appears, the tax table 
revision date should be 1/7/2013.

NOTE: in addition to the superannuation guarantee increase from 9% to 9.25%, there are some other important changes that will take effect from July 1, 2013. 
for information about what’s changed for the new payroll year, visit myob.com.au/eofy

once this process is complete, you’re done!

ACS65410/0413/EoPy
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